
 

 514 

514 
I Simpósio Nacional de Geografia e Gestão Territorial e XXXIV Semana de Geografia da Universidade Estadual de 

Londrina 
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Resumo: O desenvolvimento de sistemas computacionais possibilita a criação e aperfeiçoamento de softwares para 
aplicação dos Sistemas de Informação Geográfica abrindo um campo vasto de possibilidades de aplicação das 
geotecnologias para o estudo geográfico como objetivo de planejamento e gestão territorial. A urbanização torna-
se um processo hegemônico nas diversas escalas de análise, onde apresenta aumento da proporção de pessoas 
residindo nas cidades, esse processo sem planejamento adequado apresenta diversos problemas, entre as 
inundações urbanas. Para análise da bacia hidrográfica utilizou-se de uma proposta multiescalar, variando da bacia 
hidrográfica do rio Henrique com área aproximada de 77,89 km², e uma pequena bacia hidrográfica onde assenta-
se suas nascentes e uma porção urbanizada do município de Erechim com aproximadamente 3,25 km², nessa 
porção da bacia busca-se apresentar as transformações na cobertura e uso da terra em uma relação temporal de 41 
anos. Verificou-se que a urbanização sem planejamento adequado expõe a população aos processos naturais como 
a inundação, assim é possível constatar que o planejamento e gestão territorial torna-se importante para que os 
citadinos possam residir em boas condições ambientais. 
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INTRODUÇÃO 

No campo da Geografia observa-se durante os últimos anos, a preocupação com os efeitos da 

urbanização sobre os adereços físico-naturais e como a população torna-se afetada por processos naturais 

provocados pela ação do ser humano. O entendimento, entre os pesquisadores, é o de que os efeitos 

resultantes dos processos antropogênicos em áreas urbanas são causadores de risco para a população. 

A utilização das geotecnologias vem sendo empregada nos estudos geográficos desde final da 

década de 1960. A disponibilidade de diversas tecnologias e metodologias que empregam a utilização dos 

Sistemas de Informações Geográficas (SIGs) vem se difundindo em diversos ramos da ciência. O 

desenvolvimento de softwares aliado a disponibilidade de dados digitais vem crescendo de maneira 

expoente nos últimos vinte anos. Esse advento, faz com que o manuseio e o processamentos desses 

dados acabam criando possibilidades para aplicação de metodologias que utilizam auxilio de processos 

computacionais que possibilitam a análise e entendimento dos processos naturais e torna-se ferramenta 

importante para concretização da gestão territorial. 

O crescimento acelerado das cidades sul-americanas, para Nunes (2013), vem alterando, 

fortemente, seus adereços físico-naturais e contribuindo no desencadeamento de problemas gerados para 

seus habitantes, intensificando risco aos desastres naturais. A autora realizou um levantamento de dados 

sobre desastres naturais, nas nações sul-americanas, no período de 1930 – 2009, o qual constata que dos 
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906 casos 76,8% estão relacionados a natureza hidrometeorológica, como secas, inundações, movimento 

de massa seco e úmido, extremos de temperatura, tempestades e incêndios. 

O objetivo do trabalho consiste em analisar de maneira quantitativa e morfométrica a bacia 

hidrográfica do rio Henrique, para uma análise qualitativa do uso e cobertura da terra em suas nascentes 

que encontram-se no perímetro urbano de Erechim, Rio Grande do Sul. Dessa feita, busca-se a 

compreensão em diferentes escalas espaciais e temporais. 

 

MATERIAIS E MÉTODOS 

Para elaboração dos resultados utilizou-se Sistema de Informações Geográficas (SIG) aplicando 

procedimento técnicos relatados em Fitz (2008a, 2008b). Para realizar a análise utilizou-se dos dados em 

Carta topográfica de Erechim na escala 1:50.000 de 1979 (SG.22-Y-D-IV-1) vetorizadas e 

disponibilizadas digitalmente por (HASENACK; WEBER, 2010). Após aquisição dos dados foi efetuado 

a transformação da projeção WGS 84 para SIRGAS 2000/UTM 22S no software ArcGIS® 10.4. 

A primeira análise morfométrica aplicada na área de estudo trata da hierarquia fluvial, consiste 

em um importante parâmetro morfométrico, estabelece o ordenamento no arranjo dos canais e atribui 

efeitos comparativos entre as sub-bacias representando numericamente pela magnitude 

(FLORENZANO, 2008; IBGE, 2009).  

A classificação da hierarquia fluvial foi inicialmente aplicada por Horton (1945) e aperfeiçoada 

por Strahler (1952) que no Brasil é um dos mais utilizados: 

 
[...] assume os canais sem tributários como os de primeira ordem, estendendo-se desde a nascente 
até a confluência; os de segunda ordem surgem da confluência de dois canais de primeira ordem 
e só recebem afluentes de primeira ordem; os canais de terceira ordem surgem da confluência 
de dois canais de segunda ordem, podendo receber afluentes de segunda e de primeira ordem, e 
assim sucessivamente (IBGE, 2009, p.102) 
 

A Densidade de Drenagem (Dd) foi definida por Horton (1945), e para obtê-la aplica-se a 

equação: Dd=Lt/A, onde Lt corresponde ao comprimento total dos canais e A a área total da bacia. 

Auxilia na compreensão das características do solo e da litologia, pois pode-se identificar a porosidade e 

permeabilidade do terreno (IBGE, 2009). 

Para criar a modelagem do terreno utilizou-se o interpolador ArcToolbox → Spatial Analyst Tools 

→ Interpolation → Topo to raster, para chegar ao resultado final foi necessário editar o fluxo dos canais de 

drenagem, fazendo com que a direção de fluxo seja em direção das nascentes a jusante, considerando um 

modelo hidrologicamente consistente. Após criação do modelo foi preciso a aplicação da remoção dos 

pixels espúrios da matriz seguindo a sequência ArcToolbox → Spatial Analyst Tools → Hydrology → Fill 

realizado no ArcGIS®. Com a criação de um modelo do terreno hidrologicamente consistente, elaborou-

se uma matriz contendo a declividade ArcToolbox → Spatial Analyst Tools → Surface → Slope.  

A criação das classes hipsométricas baseou-se em regras Jenks natural breaks criadas pelo ArcGIS®, 

esse é um método de agrupamento de dados projetado para determinar a melhor organização de valores 
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em classes diferentes, procurando minimizar o desvio médio de cada classe da média. Portanto dividiu-

se em sete classes diferentes. As classes de declividade foram definidas em quatro. Para criar as matrizes 

(mde e declividade) com as classes desejadas utilizou-se ArcToolbox → Spatial Analyst Tools → Reclass → 

Reclassify, para melhor visualização das matrizes classificadas utilizou-se um filtro para agrupamento de 

quatro celular no algoritimo ArcToolbox → Spatial Analyst Tools → Generalization → Majority filter.  

Para apresentar a imagem correspondente a cobertura e uso da terra, foi necessário realizar o 

download, de uma imagem Sentinel 2B com resolução de 10 metros, datada de 11/08/2017, foram 

utilizadas para realizar a composição falsa-cor as bandas: 8 infravermelho (NIR), 4 vermelho (R) e 3 verde 

(G). Para realizar a composição foram utilizados os caminhos ArcToolbox → Data Management Tools → 

Raster → Raster Processing → Composite Bands. 

As questões referentes aos usos urbanos e a estrutura física-natural da área (relevo, bacia 

hidrográfica, hidrografia e uso e cobertura da terra) baseiam-se a partir dos seguintes autores: Guerra e 

Guerra (1997), Mendonça (2000), Coelho-Neto e Avelar (2007), Guerra e Marçal (2009), Botelho e Silva 

(2010), Botelho (2011), Jorge (2011), Silva (2011) e Nunes (2013). 

Para análise da cobertura e uso da terra em escala de detalhe foram utilizadas fotografias áreas 

datadas de 1975 (1:50.000) e 1989 (1:2.500), um ortomosaico disponibilizado pela Prefeitura de Erechim, 

datada de 2010 e uma imagem do Google Earth de 2016. As fotografias de 1975 e 1989 foram processadas 

no software PhotoScan, da Agisoft, versão 1.0.4, modo Trivial, O aplicativo PhotoScan foi de extrema 

importância para a implementação das rotinas fotogramétricas, e, mesmo com a utilização da versão 

Trivial do aplicativo, conseguiu-se atingir o objetivo na geração de ortomosaicos. A coleta das 

informações sobre os processos de inundação fora coletada em jornais locais. 

Os layouts finais foram elaborados no softwere QGIS versão 2.18.23, assim como o processamento 

dos valores de áreas e suas porcentagens foram aplicadas no Excel®. 

 

RESULTADOS E DISCUSSÃO 

A bacia hidrográfica do rio Henrique esta localizada no norte do estado do Rio Grande do Sul, 

encontra-se no Comitê de Bacia Hidrográfica do Passo Fundo, compondo uma sub-bacia desse rio 

(Figura 1). A BH do rio Henrique possui área de aproximadamente 77,89 km². 

Para Rossato (2011), na área em que está contida a bacia hidrográfica do rio Henrique, chove 

aproximadamente 1700 – 1900 mm ao ano, os meses mais chuvosos ocorrem na primavera com um 

volume de 175 – 215 mm. As altitudes elevadas do Planalto Basáltico associado ao sistema atmosférico 

favorece no volume de precipitação. As formas do relevo dessa área contribuem para os elevados totais 

pluviométricos, visto que a posição em que se encontra o vale do rio Uruguai, localizado no norte do 

estado do RS, faz com que ocorra ascensão de ar nas direções de Santa Catarina (norte) e Rio Grande do 

Sul (sul). 
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Figura 1 - Localização da área de estudo 

 

 

Os limites políticos administrativos estendem-se por Erechim, Barão de Cotegipe e Paulo Bento. 

As principais encontram-se nascentes sobre área correspondente ao município de Erechim, esse que 

ocupa a segunda maior área e possui e diversos bairros nessa área que se apresenta como uma área vetor 

de expansão nos últimos 10 anos. O município de Barão de Cotegipe apresenta menor porção e Paulo 

Bento a maior, ocupando o baixo e médio curso (Figura 2).  

A hierarquia fluvial proposta por Strahler (1952) apresenta-se que a o canal de drenagem possui 

4ª Ordem, em relação ao comprimento dos canais verifica-se que os canais de 1ª Ordem intermitente 

possui terceira maior distância em comprimento e porção, os canais de 1ª Ordem perenes configuram a 

maior distância e percentual, os canais de 2ª Ordem apresentam-se com segundo maior comprimento e 

percentual, os canais de 3ª Ordem configuram a segunda menor distância e porção, já os canais de 4ª 
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Ordem encontram-se as menores comprimentos e porções (Figura 3). Em relação a densidade de 

drenagem, a bacia hidrográfica apresenta valor de 1,47 considerada como drenagem regular. 

 

Figura 2 - Limites políticos administrativos e os bairros localizados na bacia hidrográfica 
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O mapa hipsométrico apresenta as diferentes cotas altimétricas encontradas na bacia hidrográfica, 

com elevação baixa de 578 metros e a mais alta 855 metros, obtendo-se amplitude altimétricas de 277 

metros. 

As sete classes hipsométricas (Figura 3) estão distribuídas a partir da palheta de cores, tendo o 

laranja escuro as mais altas altitudes, e correspondem as áreas de topo de morros e berços de nascentes. 

A segunda classe mais alta, em cor laranja corresponde a algumas encostas no alto curso da bacia e alguns 

topos de morros no médio curso. A terceira maior altitude em ouro, essas altitudes estão associadas aos 

canais de primeira ordem no alto curso e em encostas no médio e baixo curso. A quarta maior altitude 

em amarelo, no alto curso apresenta-se próximo aos canais de drenagem e podem estar associados aos 

terraços fluviais, já no médio curso encontram-se localizados nas encostas, e no baixo curso encontram-

se sobre topo de morros. 

A classe de cor verde corresponde a terceira altitude mais baixa da bacia, e apresenta-se próximo 

as drenagens formando terrações fluviais ainda no alto curso, já no médio e baixo curso podem estar 

associados as encostas. A segunda classe mais baixa na cor verde brilhante, encontra-se próxima aos 

canais de drenagem do médio e baixo curso, locais em que o canal começa a se apresentar meandrante. 

A classe com menor elevação, na cor verde escuro, encontra-se próximo a foz, e apresenta um canal 

meandrante sobre estrutura vulcânica. 

As classes de declividade foram divididas em quatro classes, amarelo claro é a segunda menor 

classe em área e porção, associada a essa classe encontram-se os topos de morros e colinas que sofrem 

processo de denudação e aplainamento, em menor representação associam-se aos fundos de vales 

formando pequenos terraços fluvias, destacando processos deposicionais e de acumulação. 

A classe que corresponde a maior área e porção em laranja, distribui-se por toda a área da bacia 

hidrográfica, nessa classe podem ocorrer processos de erosão. A terceira classe é a segunda maior área e 

porção na cor vermelho, essa classe forma encosta inclinadas, estão dispostas em toda bacia, mas com 

predominância ao final do médio e todo o baixo curso. 

A quarta classe em vermelho escuro, concentra-se principalmente no baixo curso, mas pode ser 

observado em menor porção sobre toda bacia, essa classe apresenta inclinação acentuada e pode 

desenvolver processo erosivos e de queda de blocos, associadas as encostas. 
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Figura 3 – Hipsometria: bacia hidrográfica rio Henrique 

 

 

 

A imagem de satélite na composição falsa cor, apresenta na cor verde água as áreas 

impermeabilizadas e a área urbana, com destaque a nordeste nas nascentes do rio Henrique área urbana 

densamente ocupado. Em vermelho escuro brilhante, identifica-se silvicultura, em vermelho escuro 

opaco, visualiza-se as áreas de mata, em rosa e turquesa claro observa-se lavouras e campo, essa classe 

que apresenta maior proporção sobre a bacia, e em azul escuro verifica-se locais com água. 
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Figura 4 – Declividade: bacia hidrográfica rio Henrique 

 

 

 

Para análise em escala de detalhe de uma área urbanizada identificou-se as transformações 

espaciais, essa área atualmente possui sete bairros incluídos de maneira parcial. A descrição encontra-se 

pautada nas transformações sobre a delimitação dos bairros atuais que corresponde ao ano de 2016, essa 

área possui aproximadamente 3,25 Km². 
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Figura 5 – Representação da cobertura e uso da terra: bacia hidrográfica rio Henrique (2017) 

 

 

O bairro Triângulo (7) na área da bacia, encontra-se dividido pela rua Antônio Cervo e João 

Batiston, em 1975 verifica-se a presença de algumas casas esparsas acima da rua Antônio Cervo, também 

identifica-se a presença do curtume Durli, entre as ruas Antônio Cervo e Daniel Durli. Em 1989 observa-

se que rua Antônio Cervo já pode ser identificada a fábrica de velas Sandero, é possível também a 

consolidação dos loteamentos iniciados em 1975, e algumas moradias próximo ao curtume, acima da rua 

João Batiston inicia-se a construção de loteamentos. Para o ano 2010 identifica-se maior densificação nas 

áreas já urbanizadas e também a construção de novos loteamentos, verifica-se maior adensamento 

vegetativo e abaixo da rua Antônio Cervo plantação de silvicultura, e acima a derrubada da silvicultura 

visualizada em 1989 e em 2010 observa-se modificações para construção de um novo loteamento, além 

a da ampliação da fábrica de velas. No ano de 2016 identifica-se a maior densificação dos loteamentos, 

assim como a consolidação de novos, a exemplo, verifica-se acima da rua Daniel Durli, observa-se 

também a expansão das instalações do curtume. 
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O bairro Presidente Vargas (6) em 1975 verifica-se que não existe nada construído, apenas em 

1989 identifica-se a presença de um aglomerado de casas em uma pequena porção, em 2010 já encontra-

se completamente urbanizado, e essa densificação aumenta em 2016. O bairro Agricola (1) em 1975 pode 

ser identificado capões de mato, vegetação rasteiras e áreas destinada a lavouras. No ano de 1989 ocorre 

aumento da vegetação em densificação, porém já é observado a presença da abertura de rua para 

construção de um novo loteamento, em 2010 ocorre a consolidação do loteamento, mas observa-se ainda 

a presença de uma porção de mata, para o ano de 2016 se consolida mais um loteamento aumentando a 

impermeabilização na porção do bairro que encontra-se sobre a bacia. 

O bairro Bandeirantes (2) em 1975 constitui-se de vegetação densa, vegetação rasteira e lavouras, 

contando com presença de poucas casas, para o ano de 1989 consolida-se as áreas de vegetação densa, e 

identifica-se aumento de casa próximo a confluência dos canais de 2ª Ordem. Em 2010 observa-se 

aumento nas áreas vegetadas e a construção de um loteamento na direção sudoeste, no ano de 2016 

aumenta-se expressivamente esse loteamento, também é possível identificar a abertura de ruas para 

construção de novos loteamentos. 

No Jabuticabal (4) acima da RS – 480 verifica-se a estruturação de um loteamento com a presença 

de ruas e casas ainda esparsas, também se verifica a presença de vegetação densa, vegetação rasteira e a 

presença de lavouras temporárias no ano de 1975. No ano de 1989 verifica-se a consolidação do 

loteamento próximo a RS – 480, também é observado a construção de loteamento em direção nordeste, 

e a existência de casas próximo a rua Daniel Durli. No ano de 2010 o loteamento a norte encontra-se 

consolidado e com alta densidade de casas, o loteamento a nordeste se consolida e as casas próximos a 

rua Daniel Durli encontram-se da mesma maneira. Em 2016 observa-se a consolidação das áreas já 

urbanizadas e é possível identificar a construção de um novo loteamento, pela figura 6 é possível observar 

a abertura de ruas em área com mata densa. 

O bairro Cotrel (3) no ano de 1975 possuía algumas propriedades rurais, os usos eram 

basicamente vegetação densa e rasteira, também pode ser identificado lavouras. Em 1989 verifica-se a 

presença de diversos aviários na direção oeste, visualiza corpos d’água e a pouca presença de mata ciliar 

no canal que nessa área é de 3ª Ordem. Nesse período predominava o uso de lavouras nessa área. No 

ano de 2010 visualiza-se a criação de um loteamento na direção norte – sul, observa-se ainda alguns 

resquícios dos aviários e a presença de propriedade rural, em direção oeste observa-se a presença de 

plantio de silvicultura e a presença de dois corpos d’água, também verifica-se a existência de lavoura e 

pequena porção com presença de vegetação densa. Em 2016 o loteamento Cotrel se consolida 

principalmente ao sul da rua Daniel Durli, ao norte ainda encontra-se uma urbanização esparsa, o que 

induz a lógica que o valor dos terrenos nessa área é elevada em comparação aos demais do bairro. 

Observa-se ainda presença elevada de silvicultura em tom de verde escuro, e vegetação densa, além de 

áreas de vegetação rasteira e lavouras, apresentando que o bairro ainda possui as duas características tanto 

de urbano quanto rural. 
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Figura 6 – Uso e Cobertura da terra: Nascentes rio Henrique (1975 – 1989) 
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O bairro Paiol Grande (5) em 1975 apresentava o uso de propriedade rural, com predominio de 

pequenas propriedades, com utilização de lavouras, vegetação rasteira e pequenas porções de vegetação 

densa, no ano de 1989 a área não recebe transformações bruscas, porém em 2010 é criado um novo 

loteamento, porém ainda se observa a presença de uma propriedade rural na direção norte, abaixo da RS 

– 480. Para o ano de 2016 verifica-se a construção de novos loteamentos, onde se observa a construção 

de novas casa e aberturas de ruas, nas áreas loteadas 2010, no ano de 2016 observa maior 

impermeabilização da terra. 

 

Figura 6 – Uso e Cobertura da terra: Nascentes rio Henrique (2010 – 2016) 

 

2010 

 



 

 526 

526 
I Simpósio Nacional de Geografia e Gestão Territorial e XXXIV Semana de Geografia da Universidade Estadual de 

Londrina 

 

Verifica-se portanto, que no decorrer de 41 anos a função da bacia hidrográfica vai se alterando, 

de propriedades rurais, para área urbana, e no decorrer dos anos essas alterações impactam de maneira 

pontual o ecossistema, assim comprometendo o meio físico e a qualidade ambiental da área. Problema 

que se tornou corriqueiro principalmente para o bairro Paiol Grande e Cotrel relaciona-se aos casos de 

inundação, por construírem os loteamentos sobre terraços fluviais e sobre os próprios canais de 

drenagem que foram sendo retificados, canalizados e tamponados. 

Adverte-se que com a urbanização e impermeabilização a montante dos bairros vem ocorrendo 

processos superficiais, no Quadro 1. Destaca-se que os processos de inundação ocorreram 

principalmente no verão, mas também foi constatado processo nos meses de inverno. 

 

Quadro 1 – Ocorrência de processos superficiais 

Datas de Ocorrência de Inundação 
12/02/2014 
26/06/2014 
14/07/2015 
02/12/2015 
21/12/2015 
31/01/2016 
17/02/2016 

Fonte: Jornais Locais 

 

Indaga-se que estão sendo construídos três novos loteamentos no bairro Bandeirantes, 

Jabuticabal e Paiol Grande, tendo em vista a existência do problema, quando se impermeabilizar os novos 

loteamentos a tendência de aumentar a vazão da água e a concentração de fluxo ocorre de maneira aguda. 

 

CONSIDERAÇÕES FINAIS 

Considera-se que o desenvolvimento de sistemas computacionais que objetivam a manipulação e 

o processamentos de dados espaciais auxilia de maneira aguda na gestão territorial, pois a partir da 

interpretação pelo viés Sistemas de Informações Geográficas e as Geotecnologias aplicadas a Geografia 

pode-se desenvolver diagnósticos e prognósticos precisos em escala apurada, possibilitando ao Geógrafo 

a inserção na discussão do planejamento e gestão territorial.  

Verifica-se no presente estudo que a urbanização sem planejamento e gestão coerentes, alicerçado 

na preocupação com a qualidade ambiental urbana apresenta situações que expõe aos citadinos aos 

perigos e riscos desencadeados por processos naturais, esses que são intensificados devido a expansão 

urbana sem planejamento que vem a servir o setor imobiliário. 
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